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CHAPTER 1 
 

Using the Training Management System (TMS) 
 
 

A.  INSTALLING TMS 
 
Installation instructions for TMS are provided in Chapter 2 of this Handbook. 
 
 
B.  STARTING TMS 
 
Start TMS by double-clicking on the TMS icon. 
 
 
If you have not recently updated your STL or 
MASL databases, you will be reminded to do so 
when you first start TMS. Click on Yes if you want 
to go directly to the SAN to download new data.  
Chapter 3 of this Handbook tells you how to 
download data from the SAN. Go to the Update 
section of this Chapter (Page 1-X) for instructions 
on how to do run an update. 
 
The TMS Main Menu will appear. TMS is now running as a Microsoft Access runtime application. 
 
All of the major TMS functions can be 
accessed by clicking (once) on the 
applicable button on the TMS Main 
Menu. 
 
Exit TMS by clicking on the Exit TMS 
button. 
 
Note: Do not double-click on TMS 
buttons. This may cause TMS to activate 
the selected function twice, resulting in an 
error message. If an error message 
occurs, simply close it, close TMS, and 
start TMS again.   
 
Please note that TMS 6.003 provides the date of the STL data and the date of the last MASL 
download at the bottom of the TMS Main Menu. 
 
Hidden Menu Items 
 
There are several hidden menu items.  Have you ever thought about how to get in touch with the 
TMS development team?  Who you “gonna” call for help?  Is it possible to get into the MS Access 
“run time” program that runs TMS? 
 
From the TMS main screen, press on Ctrl and T.   
The TMS project team screen with contact information appears. 
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Click on the X in upper right 
corner to close the screen 
when you are finished. 
 
 
 
 
 
 
 
From the TMS main screen, press on Ctrl and B.   
The Exit to Access button appears in the lower right corner. 
Press Ctrl and I to close the button. 
 
 
Note:  Do NOT go into your TMS program and make changes to any of the data tables or other 
parts of the program.  If you do, you WILL surely cause TMS to fail.  You MUST attend the 
DISAM SAM-TA, Training Automation Workshop, to learn how to use this advanced function.   
See:  http://www.disam.dsca.mil/pubs/web_Catalog/SAM-TA.htm  
 
 
C.  USING TMS LITE 
 
Selecting Switch to TMS Lite changes the full featured version of TMS to an abbreviated version 
of TMS, which is called TMS Lite (Ref “Bud Lite”).  This simplified version of TMS will accomplish 
all of the must do requirements of using TMS, but for instance, instead of having 43 reports, TMS 
Lite provides 1 report.  And, the various primary functions of TMS Lite are only “one button deep.” 
 
Click on Switch to TMS Lite. 
 
 
 
All of the TMS Lite functions are 
explained in the later sections of this 
Chapter.  So, the Page/Para 
reference will be given to those 
instructions.  Following are 
explanations of the major TMS Lite 
functions. 
 
 
 
 
 
 
 
Country Data 
The Country Data button takes the user directly to the Select Country screen so that the 
desired Country Profile screen can be selected.  See Para D, Pge 1-2. 
 
Import from SAN 
The Import from SAN button takes the user directly to the Update Data Table screen so that 
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either a MASL or STL update can be performed.  See Para E, Pge 1-4. 
 
STL w/ Remarks 
The STL w/ Remarks button takes the user directly to the STL Report Selection Criteria 
screen, so that an STL report for the appropriate training program (IMET, FMS, CTF, INL, etc.) 
can be selected.  See Para G, Pge 1-8. 
 
View MASL 
The MASL button takes the user directly to the MASL Selection Criteria screen, so that the 
appropriate MASL record can be selected or searched for.  See Para G, Pge 1-12. 
 
ITO 
The ITO button takes the user directly to the Student Selection screen, so that the correct 
student record can be selected in order to do an ITO.  See Para F, Pge 1-7. 
 
Help 
The Help button brings up the TMS Help function.  See Para N, Pge 1-40. 
 
Switch to TMS Heavy 
This button simply toggles back to the full featured version of TMS--TMS Heavy. 
 
Exit TMS 
This button initiates the process to Exit TMS.  See Para O, Pge 1-41. 
 
 
D.  COUNTRY DATA 
 
This function is used to enter data that is specific to an individual country and SAO: such as POC 
information for the SAO, the allocated level of the IMET or Expanded IMET programs, the U.S. 
MILDEP allocation, FMS Case profiles, etc. Data entries in this function must be kept up to date 
and should be changed when that data changes. 
 
Country Profile 
 
Click on Country Data in the TMS Main Menu. 
 
Click on Country Profile. 
 
Type the Country Code for your country (example 
is BN for 
Bandaria). 
 
Click on OK. 
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Type in SAO and POC information, select Program (s) of Responsibility,  select applicable 
FMS price category, and select TLA Paid options if funded by IMET.  Enter the round-trip 
Airfare, Travel Days, and Excess Baggage Cost if paid by IMET.  Accept the Days Prior to 
defaults unless timing in giving ECL test, etc., is different.  If you typically prepare your ITOs as 
much as 60 days before a student departs, change the Move Student Data to History__Days 
After ITO Date to 60 days so that the ITO will be saved for 60 days before the data is archived 
and moved to the History file. 
 
Please note that in TMS 6.0 additional POC information for the SAO training office was added to 
the Country Profile screen. Information blocks that have the block title underlined will be 
uploaded to the SAN.  Be sure to accomplish this upload to the SAN so that your SAO POC 
information is available to all IMSOs. 
 
Click on Country Allocation, IA Ceilings, PO Allocations, or FMS Case/Line to enter that data. 
IA=Implementing Agency (US Mildep), PO=Program Originator (Country Service)                   
 
Country Allocation 
 
Click on Country Allocation in the Country Profile screen. 
 
 
In the Country Allocation screen, click on Add, Delete, 
or Edit to change entries.  Click on Rollover to copy a 
line entry. 
 
 
 
 
 
 
 
Type in the desired data in Country Allocation Detail 
screen. 



1-5 

Implementing Agency Ceilings 
 
Likewise, enter data in the IA Ceilings and PO Allocations screens. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
FMS Case/Line Data 
 
Profiles can be established to track FMS Case status. TMS will then report programmed FMS 
training in relation to the overall value on the case. 
 
Click on the FMS Case/Line button in the Country Profile screen. 
 
Click on Add (Delete or Edit) to add an FMS Case 
Profile. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter all data appropriate 
to a specific FMS Case.   
 
And, that case will then 
appear in the FMS 
Case/Line table. 
 
This data will be used 
when you select and run 
an FMS Case Summary 
report. 
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Table Data 
 
Click on Table Data from the Country Data screen. 
 
To view directly any of the preceding data displays, click on that table 
on the Table Data screen. 
 
Note: If you have imported data for more than one country into your 
TMS, click on Country Profiles and use the Delete function to 
completely delete all data for a specific country. 
 
 
 
 
 
 
 
 
 
E.  UPDATE 
 
This function provides the means to update the STL, MASL, and other data tables. Replacement 
(newly downloaded) database files must be available in the C:\TMS\DOWNLOAD directory for 
the update to be successful. When you run an Update, the data file you are importing completely 
overwrites the data that was already present in TMS, unless you respond Yes to Post Pending 
Changes. 
 
Updating STL Data 
 
Click on the Update function in the TMS Main Menu. 
 
 
Click on the Import New STL (available daily) function from the 
Update Data Tables menu.  If you only have been given access to the 
data for one country, TMS will automatically go into the update process 
for that country.  If you have access to more than one country, click on 
the Country for which the update is desired.  Click on Import to import 
the new STL data. 
 
 
 
 
 
 
 
 
Wait while numerous queries are being 
run.  An hour glass cursor and black 
screen  will indicate that TMS is running 
the queries--just wait until finished.  
 
 
 
 
 
Note:  There are several country database and database text files (i.e., BN.DBF, BN.DBT, and 
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BN_DIADS.DBF files) present in the compressed BN.EXE file that is downloaded to the 
C:\TMS\DOWNLOAD directory.  The C:\TMS\DOWNLOAD directory is the default directory that 
is used as the download directory for your training data. You do not have to use this directory. 
You may establish any directory of your choice and then identify that directory to TMS via the 
Tools--Download Path function. The data normally is downloaded from the Training, ISTL Data 
Download function of the SAN Web. But, the data files could be sent to you as an E-Mail 
attachment or via a mailed disk. Contact your Unified Command training manager if you are 
having trouble downloading your training data.  See Chapter 3 of this Handbook for instructions 
on Downloading Data from the SAN. 
 
At this point, you will be asked three questions. 
 
First—Do you want to see a Reconciliation 
Report? Normally, respond No, unless you want to 
see the major changes that have taken place in the 
STL data file since the previous Download and 
Update. 
 
 
Second—Do you want to Accept this STL? 
Always respond Yes so that the STL data you 
have downloaded and imported will be saved. 
 
 
 
 
 
 
Third--Post Pending Changes? Selecting Yes will 
cause any changes that you have made by editing 
your STL to be appended to the new Military 
Department STL data that you are importing. 
Otherwise, the data import will overwrite your STL 
data. 
 
 
 
 
 
Click on OK for New STL Accepted. 
 
 
 
 
 
Updating MASL and Other Data Tables 
 
Click on Import MASL (available daily) to replace the MASL, Course Description, E-IMET 
Courses, Location Table, and other data tables. A weekly update of the MASL is probably 
sufficient.   
 
Updating OCONUS Air Fares 
 
Click on Update OCONUS Airfares and update that data semi-annually. 
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Importing Historical Data 
 
Click on Import History (available yearly) to import a complete set of historical data records. 
This is a new feature in TMS 6.003 that provides an annual update of all data records currently 
contained in the MILDEP computer systems. In order to run a Historical update, you must 
Download the Historical data file from the SAN. To be implemented soon.  
 
 
F.  STUDENT DATA 
 
The Student Data function provides a means of capturing the personal information on and 
keeping track of all students being processed for U.S. training.  This student data is then entered 
automatically into the Invitational Travel Order (ITO) when preparing that document. 
 
ECL Tracking 
 
This function first captures data on the students when they report for English Language (ECL) 
testing.  Once it has been decided what training the student will attend, the student can then be 
associated with that training line. 
 
Click on Student Data from the TMS Main Menu. 
 
Click on ECL Tracking from the Student Menu. 
 
 
 
 
 
The ECL Test Tracking screen appears.  This screen contains 
the list of all candidates to whom the SAO has given an ECL test. 
 
Click on Add to enter data on a 
newly tested student. See data 
entry screen below. 
 
Click on Del and Edit to delete 
and edit an entry. 
 
Click on Quit to save. 
 
 
 
ECL data entry screen. 
 
To save, click on Save/Quit. 
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Student Data 
 
The Student Data function provides the data input screen to capture all of the data about that 
student that is required for completion of the ITO. 
 
Click on Student Data from the TMS Main Menu. 
 
Click on Student Data from the Student Menu. 
 
Enter data that will permit search for the correct training 
line.  Normally, entering just the Program Year (PY) or the 
FMS CaseID (Ex. SMA999) will get you to the desired 
training line.  But, you can be even more specific, by 
entering: the Implementing Agency (IA)--B, D, P or the 
Work Sheet Control Number (WCN).   
 
 
Assuming that you have received information 
on a particular student who is to attend 
training for a specific WCN training line, 
double-click on that WCN training line.  Or, 
click on that line and click on Edit. 
 
Other Student Data functions allow you to:   
Del Student—delete the entire WCN 
sequence of courses for the student, Del 
ITO—delete the ITO for the student, Find—
search for a specific WCN, Track—view the 
entire WCN track (courses) the student is to 
attend. 
Enter the remaining 
Student Information that 
applies to the student:  
Gender, Date & Place of 
Birth, Medical & 
Security  Certification w/ 
Dates, Service and 
Service No., Grade 
(Country and US), 
Passport No., Unit of 
Assignment, Flight 
Crew Member, Current 
Position, Instructor, ITO 
Date (if published), 
Dependent information, 
and Remarks. 
 
Click on Save/Quit to 
save. 
 
Note:  All data fields with 
an underlined label will 
be uploaded in the SAN Update (upload to the SAN) function. 
 
 
 



1-10 

Other Student Information Functions 
 
Click on ECL Names to select a student, who has already been given an ECL test, for a specific 
course. 
 
Click on Track to view the entire WCN training sequence. 
 
Click on ITO if you wish to go on and do the Invitational Travel Order.  Likewise, click on Copy 
ITO if you wish to copy an ITO. 
 
Click on IMSI if you wish to do an International Military Student Information form (Biographical 
data sheet) for the student. 
 
Click on Print if you want to print a Student Record report. 
 
Click on Undo if you want to clear information you have just entered for a student. 
 
Click on Arrival Msg if you want to prepare a student Arrival Message to be uploaded to the 
SAN. 
 
 
G.  VIEW 
 
The TMS View function is completely different from the previous version of TMS. There is far 
greater capability in this function.  Now, all of the downloaded TMS databases can be viewed 
and searched, and the STL, E-IMET, and Location Table data can be edited. In the STL View 
function, a complete IMET program or FMS case can be rolled over to create a new, planning 
program.  Existing WCNs can be copied and replicated in the program.  While viewing specific 
MASL data, the specific Military Service course description and training location information can 
be viewed and printed. Check it out!   
 
Click on the View function from the Main Menu. 
Click on the desired database that you wish to view. 
 
 
 
 
 
 
 
 
 
 
 
Viewing or Editing STL Data 
 
This function provides for the viewing and editing of the Standardized Training List (STL) 
database. 
 
Click on View/Edit STL from the View Menu. 
 
To view specific sub-sets of the STL data, enter: 
1.  For a specific IMET program year—enter PY (02, 
03, etc.). 
2.  For a specific FMS case—enter Case ID (TAB, 
OAX, etc.).   
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3.  For all training (all funding sources) in a given FY—enter Price Year (02, 03, etc.). 
4.  Normally, the implementing agency code IA (B-Army, D-Air Force, P-Navy) and the type of 
assistance code TA (1-IMET, F-FMS) are not specified.   
And, click on OK. 
 
It is a good idea to limit the data you are working with.  TMS runs a lot of queries when you close 
this function, and it will run faster if you limit your data.  
 
Click on OK only to view the entire STL from the beginning. 
 
 
 
Scroll up or down, Page 
Up/Dwn, etc. to the desired 
WCN (training line). 
 
Double-click on the WCN 
training line to bring that 
data up, or click on the WCN 
line and then click on 
View/Edit WCN. 
 
 
 
 
 
 
Viewing Program Value 
 
An entirely new feature of TMS allows you to view at a glance the current status or value of the 
program.  This appears in the inset at the upper right corner above.  Thus, you can see the total 
value of training programmed by each MILDEP (B, D, and P). You see the value of IMET priority 
A in relation to the service ceiling, the difference and the value of any priority D training. 
 
If you have made any changes to the program, clicking on the Recalculate button will re-compute 
your program value. 
 
Finding a Training Line 
 
Click on Find WCN from Country STL screen, and type in the desired WCN. Click on OK. 
 
Click on Next WCN to go to the next WCN. 
 
Deleting Training 
 
To delete a training line, click on the line in the Country STL screen, and click on Del Line. 
 
To delete a complete WCN sequence of training, click on the line and click on Del WCN. 
 
To deselect the deletion, just click on Del Line or Del WCN a second time (see the toggle 
window to left). 
 
Note: Once you select Quit the deletion will be executed and you cannot undo the deletion. 
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Copying a Training Line 
 
Click on the training line to be copied and then click on Copy WCN from the Country STL 
screen.  
 
Type in the desired WCN number for the new training line and 
click on OK. The training line will be copied with the new WCN. 
The training dates from the WCN being copied will not appear in 
the new WCN. 
 
Adding a New Training Line 
 
Click on Add WCN from the Country STL screen to add a new WCN training line to the program. 
 
Type in the data. Typing in the MASL 
ID and clicking on another field will 
cause all of the MASL data to be 
entered automatically (assuming it is 
in the MASL). 
 
Double-clicking on the appropriate 
MASL price will cause the Unit Cost 
to be entered along with the Total 
Cost. If appropriate, the TLA will be 
calculated and entered. 
 
Click on Add Line to add another 
training line to the program or 
Save/Exit to save the change. 
 
Rolling Over a Country Training Program 
 
The purpose of this function is to provide a means for the training manager to set up a new 
program for planning purposes by copying an existing training program and saving it as a 
different program. This helps a great deal in the development of next year’s training program. In 
the example given, XX is used as the new planning program year. 
 
Click on Rollover from the Country STL screen.   
Enter the Country Code, IMET Program Year or 
FMS Case ID, and the Implementing Agency 
(managing Mil Svc). Then enter the new PY or 
Case ID you wish for the rollover. Click on OK. 
 
Click on Rollover Delete to delete a rollover. 
 
The new program is now available for viewing. 
Note that all dates are deleted and costs are inflated by 10%. 
 
Viewing and Editing a Training Line 
 
To View or Edit a training line, double-click on that line in the Country STL screen (above) or 
highlight and click on View/Edit WCN. 
 
The entire STL data display for the selected WCN training line appears as seen in following 
screen. Refer to Appendix A of this Handbook for an explanation of all data fields. All of the WCN 
suffix lines (the B, C, lines, etc.) are shown in the inset box in lower right. Any Remarks are 
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shown to the lower left. In the upper right inset, the total value of the entire WCN sequence is 
shown. All data fields that appear in Yellow will provide additional data by double-clicking on 
them. 
 
To Edit a training line, 
click on the field to be 
changed and make the 
change (i.e., 2nd QTR 
changed to 5th QTR). 
 
To Edit the b, c, d 
lines, etc., doubleclick 
on that line at the lower 
part of the screen. The 
information for that line 
will be displayed in the 
top portion of the 
screen. 
 
To view information 
from the MASL for a 
particular training line, 
simply double-click in 
the MASL ID block and 
it will be displayed. 
 
Click on Save/Exit when finished with that training line. 
 
When you are finished editing other lines on the STL, Click on Quit/Save.  This will bring up the 
Current STL Changes screen. 
Since you have made changes to the STL, TMS asks you what you want done with those 
changes. 

 

Click on Save to keep the change you made to your STL data. 
 
Click on Send/Save if you wish to send a change message to the Mildep to request the 
change. 
 
Click on Discard if you do not want the change saved. 
 
Click on Ok and Save/Quit when finished. 
 
Note: TMS will not automatically send your change request via an E-mail message to the 
appropriate MILDEP training agency.  You will have to go to the Mail function on the TMS main 
menu to do this. 
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Viewing MASL Data 
 
This function provides access to the MASL database, the new Course Information database, 
and Training Activity Information which was previously only available in the military service 
catalogs. The data can be found by MASL ID, Course Title (or portion of), military service 
Course Number, and by MASL ID category. From anywhere in TMS, double-clicking on a 
MASL ID number will display the detail MASL data. 
 
Click on MASL from the View Menu. 
 
Enter a MASL ID to go to that MASL entry.  Enter a portion 
of the MASL ID to access all MASLs containing that portion 
(i.e., B171). 
 
Enter the Location Code to access all MASLs (courses) at 
that training location. 
 
Or, click on OK without entering a MASL ID or Location Code, to go to the beginning of the MASL 
database.   
 
 
 
 
Then press Page Up/Down or scroll 
to the desired MASL. 
 
 
 
 
 
Either double-click on the desired 
MASL or click on it and then click on 
View. 
 
MASL Data 
 
See Appendix A, Part II of this Handbook for a detailed description of all MASL data elements.   
 
Click on View Course Descriptions to 
view the course description. 
 
Click on Print MASL Detail to print the 
detail MASL data.  
 
Click on Print Course Descriptions 
and Notes to print the course 
description. 
 
Double click on the MASL ID in the 
Prerequisite block to view the MASL 
data on the prerequisite course.  Click on 
Return to return to the original MASL. 
 
Double-click on the Location Code in 
the LOC block to view the military 
service training activity or school  



1-15 

information. 
 
Note:   All data fields in TMS that have a Yellow background provide additional information when 
selected (double-clicked). 
 
Course Descriptions and Course Information 
 
Click on View Course Descriptions in the MASL screen above to view the course description in 
the Course Information screen. 
 
 
Click on the right edge of 
each Course Information 
remarks block to use the 
hidden scroll bar to view 
the entire content. 
 
Click on Print to print the 
Course Information.   
 
Click on Done to return to 
the MASL screen. 
 
 
 
 
 
 
 
Click on the Printer Icon in upper left corner to 
print the Course Information. 
+ 
Click on the MS Word Icon to generate a 
.RTF document to be saved or sent. 
 
Click on the E-mail Icon to automatically send 
the Course Information as an E-mail 
attachment. 
 
Click on the X in upper right corner of 
document to return to the MASL detail 
information screen. 
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Training Location Information 
 
Double-click on the Location Code in the LOC block of the MASL screen above. 
The complete point of contact information for the IMSO office appears. 
 
 
 
 
 
Click on Print to print the Course Location Information.   
 
Or, Click on Additional Loc Information to view the 
Location Information.   
 
 
 
 
 
 
 
 
 
 
Click on the Printer Icon in upper left corner 
to print the Location Information. 
 
Click on the MS Word Icon to generate a 
.RTF document to be saved or sent. 
 
Click on the E-mail Icon to automatically 
send the location information as an E-mail 
attachment. 
 
Click on the X in upper right corner of 
document to return to the MASL detail 
information screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finding or Locating Required Training 
 
Click on MASL from the View Menu.  Click on OK. 
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Click on Find MASL ID and enter the specific MASL ID or portion thereof.  Click on OK. 
 
Click on Find Title and type in a key word that you think would be contained in the Course Title. 
Click on OK. 
 
Click on Find Course ID and enter the military service course number.  Click on OK. 
 
Click on Category and select the desired category 
within which you think the training fits.  This allows you 
to break the entire MASL down into logical categories 
of training that you can then examine to find specific 
course offerings.  Click on OK. 
 
Once you have located the desired training, 
double-click to view the MASL detail data. 
 
 
 
Viewing Expanded IMET Courses 
 
This function provides MASL data for all courses that qualify as Expanded IMET. 
 
Click on E-IMET Courses from the View Menu to view the list of all Expanded IMET courses. 
 
Click on Add, Delete, or Edit to add, delete or edit 
an E-IMET data entry.  
 
Note:  Courses are continuously being added and 
deleted from the E-IMET data table. While this 
data table is updated on the SAN, if for any reason 
an EIMET course is missing from the E-IMET data 
table, it can be added. 
 
Click on Find to search for a specific MASL ID. 
 
After finding and highlighting the desired E-IMET 
course, click on the MASL button to view the 
MASL data for that course. 
 
 
 
Viewing and Editing Location Table Data 
 
The Location Table database provides a table of Location Codes for all military service schools 
and training locations. 
 
Note: Many TMS users have experienced difficulty in doing Invitational Travel Orders because 
the Location Code entered by SATFA, NETSAFA, and AFSAT in the STL data is not contained 
in the Location Table database. To do an ITO, TMS must be able to find the Location Code in 
the Location Table database in order to print out the name and address of the training location in 
the ITO.  Consequently, be sure to edit the Location Table and add any location codes that show 
up in the STL data but are not contained in the Location Table. It is quite simple to do this. 
 
Click on Location Codes from the View Menu. 
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Click on Add, Delete, or 
Edit to add, delete or 
change a Location Table 
data entry. 
 
Enter the new Location 
Code data or edit the old 
data as needed. 
 
Click on Find Loc, type in 
the desired Location Code (i.e. BCY for the US Army Armor School at Ft Knox KY), and click on 
OK. Or, 
 
Click on Find Location and enter a word that you would expect to find in the location field of the 
location table data (i.e. Knox for Ft Knox KY). 
 
Click on Quit to return to the View Menu. 
 
Viewing Oral Proficiency Interview (OPI) Requirements 
 
This function provides the ability to view Oral Proficiency Interview (OPI) requirements. 
 
Click on OPI Requirements from the View Menu. 
 
Click on a listed course and then click on 
EDIT to change that entry.  
 
Likewise click on ADD or DEL to add and 
delete entries. 
 
Click on MASL to view the complete MASL 
data for a given course. 
 
Click on FIND and enter the MASL ID to find 
a course. 
 
Click on QUIT until you return to the TMS Main Menu. 
 
 
H.  FORMS 
 
This function is used to generate Invitational Travel Orders (ITOs), International Military Student 
Information (IMSI) forms, IMET Waiver Requests, Two Year Training Plans, and to print multiple 
or a blank ITO. It allows the user to create a default ITO format with unique information for that 
SAO on it.  Default ITOs can be done for: IMET, FMS funded training, different FMS cases, and 
for different military services, etc. 
 
Click on Forms from the TMS Main Menu.   
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Default ITOs 
 
Click on Default ITOs from the Forms Menu. 
 
 
 
Click on Add, Del, and Edit as needed to add, delete, and change 
any ITO Defaults. 
 
 
 
 
 
On the Default ITO Selection screen type 
the Country Code, click on IMET, FMS, or 
INL/Others.   
 
For IMET click on Army, Air Force, or Navy.  
For FMS enter the FMS Case ID (if Case ID 
has six characters, enter all six) or click on 
OK and do a default for all Army, Air Force, 
or Navy cases. 
 
Click on OK to save the default. 
 
Enter the ITO “default” data on the Default ITO screens as seen below. Press Page Down or use 
the Scroll Bar. (A typical ITO default for a Bandarian IMET ITO has been established below).  
Click on Quit to save entries. 
 
Note: Only the blocks you are able to default are displayed in the ITO default screens. 
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Invitational Travel Orders (ITOs) 
 
Remember that an ITO can be done directly from the Student Data function. In other words, after 
you have entered data for a student attending a specific WCN training sequence, you can click on 
ITO in that function and create the ITO. You do not have to close Student Data and open the 
Forms function to do the ITO.  But, our explanation will be given here. 
 
Click on ITO from the Forms Menu. 
 
The Student Selection screen opens, as it did in the Student Data function. 
 
Enter data that will permit search for the correct training 
line.  Normally, entering just the Program Year (PY) or the 
FMS CaseID (Ex. SMA999) will get you to the desired 
training line.  But, you can be even more specific, by 
entering: the Implementing Agency (IA)--B, D, P or the 
Work Sheet Control Number (WCN).   
 
 
Assuming that you have received information 
on a particular student who is to attend 
training for a specific WCN training line, 
double-click on that WCN training line.  Or, 
click on that line and click on Edit. 
 
 
 
 
 
 
   
 
Enter the remaining Student 
Information that applies to the 
student:  Gender, Date & 
Place of Birth, Medical & 
Security  Certification w/ 
Dates, Service and Service 
No., Grade (Country and US), 
Passport No., Unit of 
Assignment, Flight Crew 
Member, Current Position, 
Instructor, ITO Date (if 
published), Dependent 
information, and Remarks. 
 
This information will be coming 
in at different times from the 
Country training officials.   
Click on Save/Quit to save 
each time you have entered 
data on the student. 
 
Note:  All data fields with an 
underlined label will be 
uploaded in the SAN Update (upload to the SAN) function. 
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When you are ready to do the ITO (when you think you have all the student’s information input),  
click on ITO on the Student Information screen.  
 
The actual ITO form appears with all data entered automatically from all databases. 
 
Note: Many TMS users have experienced difficulty in doing Invitational Travel Orders because 
the Location Code entered by SATFA, NETSAFA, and AFSAT in the STL data is not contained 
in the Location Table database. To do an ITO, TMS must be able to find the Location Code in 
the Location Table database in order to print out the name and address of the training location in 
the ITO. If necessary, go back and edit the Location Table and add any location codes that show 
up in the STL data but are not contained in the Location Table. See Page 1-16 of this Handbook. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All ITO entries can be over ridden and changed. Make sure all entries on the ITO are correct in 
accordance with the JSAT, Chapter 10. 
 
Click on Page 1 through Page 4 to view those pages, Page 5 provides a continuation sheet. 
Use the Scroll Bars as needed to view each page completely. 
Click on View ITO to see the final letter format ITO that TMS generates. 
Click on Print ITO if printing is desired. 
 
Note: Printing an ITO is the creation of an official financial document. Printing the ITO causes it to 
be locked in TMS. You cannot go back into the ITO and make changes. You will have to amend 
the ITO to make any subsequent changes.   
 
Click on Save/Exit to save the ITO. 
Click on Abort/Exit to exit without saving the ITO. 
 
Printing an ITO 
 
Click on ITO from Forms Menu. 
Select the desired training program. 
Double-click on desired training line from Student Data screen. 
Click on ITO from Student Information screen. 
Do a final edit of the ITO on all four pages (all entries can be overwritten). 
Click on Print ITO from the View/Edit ITO screen. 
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Click on Yes if you are 
sure you are ready to 
publish the ITO. Any 
subsequent changes to 
the ITO will require an 
ITO Amendment. 
 
Click on the Print toolbar 
button in upper left corner. 
 
Click on File and Close to 
exit print function. 
 
Click on Quit to exit. 
 
Note: See sample ITO in 
Appendix B. 
 
 
 
 
 
 
 
 
 
Amending an ITO 
 
If it becomes necessary to make a change to an ITO that has already been printed, remember 
that the ITO has been locked and any changes to be made must be accomplished via an ITO 
amendment. 
 
Click on ITO from Forms Menu. 
Select the desired training program. 
Double-click on desired training line from Student Data screen. 
Click on ITO from Student Information screen. 
 
 
Note that the ITO was 
previously printed and 
changes must be done via 
an amendment 
 
Click on Amend ITO to 
amend an ITO that was 
previously created. 
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Click on the ITO Section 
drop down box and click on 
the ITO item to be changed. 
 
Type in the correct 
information in the Amend 
to read as block. 
 
You can change any number 
of items.  A second change 
block is available and new 
ones appear as needed. 
 
Course changes are 
entered in a separate block. 
 
Enter the authority for amendment in that block. 
 
You can view the ITO Amendment to check it.   
 
As with the printing of the ITO, when you click on Print ITO Amendment, the amendment is 
locked and no further changes can be made to it.  Additional changes will have to be made via a 
new amendment. 
 
Sending an ITO as an E-mail Attachment 
 
Proceed as in the previous section to the point of printing an ITO. 
 
After selecting Print ITO from the View/Edit ITO screen, click on the Send toolbar button in the 
upper left corner of your screen (third of three buttons). 
 
Then click on Rich Text Format in the Send screen that appears and click on OK. 
 
Click on OK again, if asked to Choose Profile. 
Note: This will vary, depending on your default E-mail package (MS Exchange, etc.).   
 
 
An E-mail message will be initiated for 
you using your established E-mail 
program, with the ITO (or any other TMS 
generated report) already inserted as an 
attachment.   
 
Obviously, you will then want to address 
the message to your Mildep desk 
officer, IMSO at training activity, and 
other required E-mail recipients.   
 
Ask your Mildep desk officer to help 
you in identifying the E-mail addresses of 
required ITO recipients. 
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Saving ITO to Your Computer Hard Drive 
 
Proceed as above to the point of printing an ITO. 
 
After selecting Print ITO from the View/Edit ITO screen, click on the Word toolbar button in the 
upper left corner of your screen (second of three buttons). 
 
Click on Yes. 
 
Click on File and Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the drive and the directory where 
you want to save the file ITO document. 
For instance, double-click on the C:\, 
then the TMS directory, then the 
Download directory 
(C:\TMS\Download).  
 
Give the file a name that will let you keep 
track of the ITOs.   
 
Click on OK. 
 
The ITO will then be saved in the 
designated directory with the .rtf file 
name you gave it. 
 
Using the MS Access Snapshot Function 
 
Many TMS users have painfully observed reformatting difficulties when converting the MS Access 
generated ITO to a .RTF or MS Word format.  Often during this conversion process Microsoft 
Access scrambles the ITO.  To avoid misplaced lines in the ITO, use Snapshot (a Microsoft 
Product) to “take a picture” of the ITO and save it on your computer without converting it to MS 
Word.  This method also prevents the receiver from altering the ITO.   
 
Create the ITO in TMS as previously  discussed. 
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Instead of clicking the W in the top left corner of the screen 
sending the ITO to MS Word: 
 
Click on the Camera icon and Microsoft’s Output To form 
will appear. 
 
In the Save In block select a folder location. 
 
In the File Name block accept the default name or create a 
new name. 
 
Click the Export button to save the file to your computer. 
(Make sure you know the location of where you saved the file AND what the file name is.)   
 
The file will be saved to your computer with a .snp extension.  The Snapshot Viewer will also 
appear displaying the ITO.  Close the viewer when you are done. 
 
Attach this file to an E-mail message and send it to the appropriate recipients. 
 
To  automatically attach the ITO in Snapshot format to an E-mail message: 
Click on the Camera with Envelope icon. 
 
An E-mail message form will appear with the ITO already attached as a .snp file.  Address the 
E-mail and send it to the appropriate recipients. 

 
Note:  The above procedures can be used to create Snapshot files of any report created with 
TMS.   
To create Snapshot files, you must have the Report Snapshots program installed on your 
computer.  (This comes with Microsoft Access 97 SR-1, Microsoft Access 2000 and Microsoft 
Access XP.)   [When following the above procedure, if you do not see “Snapshot Format (*.snp)” 
in the dropdown box for the “Save As Type” block then the Report Snapshots program is not 
installed on your computer.] 
To view Snapshot files, the user must have the Snapshot Viewer program installed.  (This 
comes with Microsoft Access 97 SR-1, Microsoft Access 2000, and Microsoft Access XP.  It can 
also be downloaded for free from Microsoft’s webpage.  The file download for Snapshot Viewer 
and additional information about Snapshot can be found at the following address: 
http://www.microsoft.com/accessdev/articles/snapshot.htm?gssnb=1 
 
Printing Multiple ITOs 
 
This function will allow you to print any ITOs that you have previously prepared. 
 
After you have completed all your entries in an ITO and you have clicked on Print to lock the ITO, 
instead of going ahead and printing at that moment, simply close the ITO instead of sending it to 
the printer.  Do this for as many as you want to print (for instance) while you are at lunch. 
 
Click on Forms from the TMS main menu. 
 
Click on Print Multi-ITOs from the Forms menu. 
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Click on the box under the column Print 
ITO for the ITOs that you want to print.  
(Click on the All button to select all of 
them.) 
 
Then click on Print.  (Go to lunch…..) 
 
Click on Quit after the printing is 
complete. 
 
 
 
 
 
 
Printing a Blank ITO 
 
Click on Forms from the TMS main menu. 
 
Click on Print Blank ITO on the Forms Menu screen. 
 
International Military Student Information (IMSI) Form 
 
This function provides an automated format for completion of the International Military Student 
Information (IMSI) form. The JSAT currently requires the preparation of IMSI forms for all officer 
students and the U.S. Army Sergeant Majors Academy. Submission of the form for other enlisted 
IMS is optional. 
 
Click on Forms from the TMS main menu. 
 
Click on IMSI from the Forms menu. 
 
Again, as you have done previously in selecting the student, select the appropriate student 
record. 
 
Click on IMSI from the Student Information screen that appears.   
 
Then, in the International 
Military Student Information 
(IMSI) screen that appears, 
complete the required 
biographical data entries. Use 
the scroll bar to move to the 
rest of the form. 
 
Click on Undo to clear any 
entries you have made. 
 
Click on Delete to delete any 
IMSI form (data) you have 
previously created. 
 
Click on Save/Quit to save all 
entries for the specific WCN 
training line (student). 
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Click on Print to print the form. 
 
The IMSI form can be sent as an E-mail attachment just as you can for an ITO. Use the same 
procedures as given to send the ITO as an attachment. 
 
IMET Program Waiver Request 
 
This function allows you to create an IMET waiver request when required in accordance with the 
SAMM, Chapter 10. 
 
Click on Forms from the TMS main menu. 
 
Click on IMET Waiver Request from the Forms menu. 
 
Click on the desired country IMET (or 
possibly FMS) program using selection 
menu on left of screen. 
 
Click on the desired Implementing 
Agency. 
 
Double-click on the desired training 
sequence. 
 
Click on the desired line for which you 
need to request a Waiver. 
 
Click on OK. 
 
In the IMET Waiver Request screen type in all information pertinent to the specific IMET waiver 
request in accordance with the SAMM reference.  Use the scroll bar to access the remainder of 
the form. 
 
Click on Undo to delete any entries 
made in current session. 
 
Click on Delete to delete a 
previously generated waiver request. 
 
Click on Create/Print to print the 
waiver request. 
 
Click on Save/Exit to save any work 
accomplished and return to the 
Forms menu. 
 
Click on Quit to exit without saving. 
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Two Year Training Plan For Annual TPMR Submission 
 
Click on Forms from the TMS main menu. 
 
Click on Two Year Training Plan from the Forms menu. 
 
Click on Add to create a two year training plan. You can also Copy, Delete and Edit a previously 
prepared Two Year Training Plan. 
 
Type in your Country Code, Year of TPMR Conference, and 
click on the Name block (default name appears).  
 
Click on OK. 
 
 
 
 
 
 
Type in all pertinent information on both Page 1 and Page 2 of the Two Year Training Plan. 
 
Note: For specific informational content of the Two Year Training Plan, you must refer to the 
annual Training Program Management Review messages and other guidance put out by your 
Unified Command training manager.  All TPMR messages can be found on the SAN Main 
Training Menu. 
 
Click on Undo to delete any entries 
you have made to the current record. 
 
Click on Page 2 to go to page 2 
(click on Page 1 to return). 
 
Click on PPR to enter Positions of 
Prominence data into TMS.  
Refer to the History function in this 
Chapter and follow the Positions of 
Prominence instructions. 
 
Click on IMET WVR to go directly to 
an IMET waiver request.   
Refer to the IMET Waiver  
instructions above. 
 
 
Click on Print/Export to print the 
training plan or export the training 
plan and save as a separate file. 
 
Click on Spell Chk to do a spell 
check. 
 
Click on Save/Quit to save and quit. 
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I.  MAIL 
 
This function is used to create, address, store, and send messages dealing with your training 
program.  Normally, this function is used to keep track of messages dealing with additions, 
deletions, and changes to your country training program. It is not used to keep track of 
messages you have sent with Email attachments such as the ITO, etc.  
 
Whenever you make a change (addition, change, deletion) to your training program using the 
View/Edit STL function, and you select Send after saving the change, a change message is 
automatically generated reflecting the requested change.  
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Mail function on the TMS main menu and you will see those change messages and 
can work with them. 
 
Click on: 
New to do a new message, 
Copy to copy a message, 
Del to delete a message, 
Edit to edit a message, 
Quit to quit. 
 
Click on a message and 
then click Edit. 
 
 
 
 
 
 
You can address the 
message and 
make any changes to the 
message body, as 
desired. 
 
You can then Send, Hold, 
Discard or Print 
the message. 
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Click on Send and the message will be automatically transferred to your established E-mail 
system, in the following example, MS Outlook. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now, the status of the above 
message is Sent. 
 
 
 
 
 
 
 
 
 
J.  REPORTS 
 
This function provides a series of Detailed, Summary, and Calendar Reports on both an 
individual or multi-country basis that have been designed to assist in the management of IMET 
and FMS training programs. There is also a Custom Report function for the STL (country 
program) data. The established (canned) reports should meet the needs of most users. Should a 
user desire to prepare his/her own unique reports, this can be done using the Custom Report 
function. 
 
Note: The DISAM SAM-TA course is conducted annually at DISAM to teach experienced TMS 
users advanced TMS usage and the use of Microsoft Access. Obviously, using MS Access will 
result in any manner of custom report.  See http://www.disam.dsca.mil/pubs/web_Catalog/SAM-
TA.htm  for a complete course description. 
 
Note: Refer to Appendix A, Part III of this Handbook for all STL Data elements. 
 
 
Click on Reports from the TMS Main Menu. 
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Click on Single or Multi-Country Reports, or Custom STL 
Reports as desired.   
 
Single-Country Reports are the reports used by an SAO to 
manage that country’s training program. 
 
Multi-Country Reports are intended for the use of training 
managers at the Unified Command or other command levels who 
have responsibility for multiple country programs. 
 
Custom Reports provides a function where the user can select 
specific data fields to run a report on.  Thus, the user can design his/her own report.   
 
Note:  A representative selection of available reports and how to initiate them follows. Not all 
reports will be discussed. Examples of the reports are provided in Appendix B. TMS users should 
run all reports applicable to that user’s training program and examine them. 
 
Single Country Reports 
 
Click on Reports on the TMS Main Menu and click on Single Country Reports.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Detail Single Country Reports 
 
Click on Country STL.  This is the standard Country STL (Standardized Training List) report.  It 
provides a report on all training that is contained in the MILDEP computer systems for a given 
Country IMET program or FMS case.   
 
 
Enter your data selection criteria.  Normally, you will 
want to do the report on a specific FY IMET program or 
a specific FMS case.  You need only enter that IMET 
PY or the FMS Case ID.  Click on OK. 
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This STL Report can be 
printed, saved as a 
Word document, or sent 
as an E-mail attachment 
as discussed in the 
previous Forms section 
about ITOs.   Click on 
the applicable tool bar 
buttons.  
 
To view the different 
pages of the report, click 
on the page arrows at 
bottom left corner. 
 
Click on the report to 
reduce to fit screen or to 
enlarge. 
 
This STL report is sorted 
by MILDEP 
implementing agency and by Worksheet Control Number (WCN).   It provides totals for the  
Course Cost, TLA Cost, and Total Cost. 
 
Other Detail Reports 
 
Country STL   Standard country report sorted by MILDEP and WCN 
Country STL (Remarks)  Country STL report with the MILDEP remarks field added. 
E-IMET STL    STL report for Expanded IMET training only. 
STL by PO    STL report by the country’s service. 
STL Filtered by Dates   STL report for a specific time span. 
STL by MILDEP/Priority  STL report by MILDEP and priority code. 
STL by Priority/MILDEP  STL by priority and then by MILDEP. 
Invitational PME STL   STL report for PME training only. 
STL OPI Requirements   Report on training requiring oral proficiency Interview. 
MASL Detail Report   Standard training MASL report.  
Student Management   Student departure date, ECL test date, and other 
Student Count    Number of training lines, students, and value for given time  
History     Standard report from history data file. 
STL/Student Report   Report with student detail data. 
STL 100% Penalty   Report on possible 100% penalties. 
IMET Funding Report   Report on status of IMET funding of program. 
 
Summary Single Country Reports 
 
Click on E-IMET Students 
 
Enter the desired IMET PY and click on OK. 
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Obviously this is a 
summary report 
that shows the 
number of 
students and dollar 
value of same by 
Priority Code and 
by MILDEP. 
 
 
 
 
 
 
 
 
 
 
 
Other Summary Single Country Reports  
 
MILDEP Ceilings   Report on value of training by Mildep. 
PO Allocations    Report on value of training by Country service. 
IMET Training (AN)   Report on value of training by Analysis category. 
IMET Students (AN)   Report on number/value of students by Analysis category. 
IMET Students (Mildep)   Report on number/value of students by Mildep. 
E-IMET Students  Report on number/value of E-IMET students 
E-IMET Summary (AN)   Report on number/value of E-IMET by Analysis category 
FMS Training (AN)  Report on FMS training by Analysis category 
FMS Case Summary   Report on value of FMS funded training. 
Non SA Case Summary  Report on value of non S.A. funded training. 
Position of Prominence  Actual Position of Prominence (PPR) report 
TYTP Attachments  Attachments to PPR  
IMET Review    Review report as used at TPMR 
 
Calendar Single Country Reports 
 
Click on First Report Date. 
 
 
Enter a date time span for which you wish to know all of the 
departing students. 
 
Do not enter anything in the PY/Case Id box so that you will 
see all students, regardless of what program they are in. 
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Other Calendar Single Country Reports 
 
Cancellation Report   Student scheduling report for cancellation dates 
First Report Date   Student scheduling report by departure date 
Report Date (PO)   Student scheduling report by Country service 
ECL Test Schedule   Student scheduling report for ECL tests 
ECL Test By PO   Student scheduling report ECL tests by Country svc 
ECL Tracking    Student mgt report with ECL test results 
Training Track End Date  Student schedule by end date of training/return to country 
 
Multi-Country Reports 
 
Click on Reports on the TMS Main Menu and click on Multi-Country Reports.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1-36 

Detail Multi-Country Reports 
 
Country STL    Standard STL data report for multiple countries 
Country STL (Remarks)  Standard STL w/ MILDEP remarks for multi-country 
E-IMET STL    Standard STL report for E-IMET, multi-country 
STL by PO    Standard STL report by Priority code, multi-country 
STL by MILDEP/Priority  Standard STL by MILDEP and Priority, multi-country 
STL by Priority/MILDEP  Standard STL by Priority, then MILDEP, multi-country 
Invitational PME STL   Standard STL invitational PME tng, multi-country 
 
Country Summary Multi-Country Reports 
 
MILDEP Ceilings   Multi-country summary rpt on value of training by Mildep 
PO Allocations    Multi-country summary rpt on value of tng by Country service 
IMET Training (AN)   Multi-country summary rpt on value of tng by Anal code 
IMET Students (AN)   Multi-country summary rpt on no. of students by Anal code 
IMET Students (Mildep)   Multi-country summary rpt on no. of students by Mildep 
E-IMET Students   Multi-country summary rpt on no. of E-IMET students 
E-IMET Summary (AN)   Multi-country summary rpt on value of E-IMET tng by AN code 
 
Summary Multi-Country Reports 
 
IMET Tng Summary (CC)  Program value summary report by Country. 
IMET Tng Summary (AN)  Program value summary report by Analysis code. 
IMET Stud Summary (CC)  Program size by no. students by Country. 
IMET Stud Summary (AN)  Program size by no. students by Analysis code. 
E-IMET Stud Summary (CC)  Program size by no. students for E-IMET tng. 
E-IMET (AN)    E-IMET summary by Unified Command or All. 
 
Custom STL Reports 
 
This function allows you to create a custom STL Report. When you click on Custom STL 
Reports a pop-up screen is displayed that allows you to create a new report or edit one 
previously created. The Custom STL Report function works as follows.  Basically, what this 
function allows you to do is to specify the specific data content that you wish the report to have. 
For instance, if you wanted to see a report on just Enlisted personnel training in your program, 
you would enter an E in the Student Code block. You can then choose to Sort the report 
however you wish. When you Print the report, it will always contain all of the data fields reflected 
in the following screen. You cannot change the actual report format or layout. However, if you 
click on the View button, you can choose to print the MS Access data table, and there you can 
limit the table to just the fields you 
wish to see. 
 
Click on Reports from the TMS main menu. 
 
Click on Custom STL Reports from the Reports menu. 
 
 
Click on New to create a new report. 
 
In addition to creating a New report, you can: 
Click on Copy to copy a report. 
Click on Edit to edit a report. 
Click on Del to delete a report. 
Click on Print to print a report. 
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Click on the data field 
block you wish to specify. 
 
Example: A report 
showing all Enlisted 
training for the current 
year (regardless of 
funding)……BN for 
Bandaria, 02 for the Price 
Year (current FY, all 
training), and an E in the 
Student Code block. 
 
Note: Refer to App A, 
Part III of this Handbook 
for all STL Data 
elements, 
 
Click on the Sort Sequence button and simply click where a zero appears and enter numerals 
specifying the order in which you want the data sorted. 
 
 
 
Example: Sorts by Mildep first and WCN second. 
 
Click on Save/Quit after sort selection is made. 
 
 
 
 
 
 
 
 
 
 
 
Click on Save Report in the previous Custom STL Report Selection Criteria screen, and type 
in a Custom Report Name. 
 
Click on View Data to view the data in a tabular format. 
Click on Print Report to print in a report format. 
Click on E-IMET Report to do a report on just E-IMET training lines. 
Click on Save Report and Quit. 
 
The created report will then be listed in the Custom Reports Menu screen. 
 
Printing a Modified Data Table in Custom Reports 
 
To print a MS Access data table display, do the following: 
 
Select the desired report in the Custom Reports Menu. 
 
Click on Edit. 
 
Click on View Data in the Custom STL Report Selection Criteria screen. 
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On the MS Access data table 
display, you can hide the data 
fields you don’t want to see by 
clicking and dragging the 
vertical line to the right of 
each data field name. 
 
Click on File (menu in upper 
left) and Print to print the data 
table that you have modified. 
This is not, of course, the finely 
finished MS Access report you printed earlier. 
 
When you close the data table display, click on Yes to save the layout changes you have made. 
This will not alter the actual Report document. 
 
 
K.  HISTORY 
 
Active student records are automatically moved to the History data archive function, 
approximately 30 days after the ITO has been executed. The exact time period depends on that 
specified in the Country Profile screen. Student records can be moved manually to the History 
archive by clicking on Move to History in the Student Data function. 
 
Click on History from the TMS Main Menu. 
 
Click on Student Data from the History Menu.   
 
Student Data that has been added to the History Database 
will be listed as seen below. 
 
 
 
 
Click on: 
Add to add a new record. 
 
Del to delete a record. 
 
Edit to change a record. 
 
Find to find a record. 
 
Move to Student to move 
the record from the 
archived History 
database to the active 
Student database. 
 
Track to view the entire WCN training track. 
 
Positions of Prominence 
 
Click on the box under Pos Prom on the Historical Student Data screen to add the student to 
the Positions of Prominence Report in your Two Year Training Plan. 
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Double-click on the record to Edit the information (or click on record and then click on Edit). 
 
 
 
 
 
Enter Position of 
Prominence information in 
the Historical Student 
Information screen. 
 
Click on Print to print and 
Undo to remove all entries. 
 
Click on Save/Quit to exit. 
 
 
 
 
 
 
Moving a Record from History File to Active Student Database 
 
Sometimes, if an ITO is done very far in advance of the student’s departure, the active Student 
record will be moved automatically to History. If this happens, and you need to amend the ITO to 
make a change, simply go into the History function and move the record back to the active or 
current Student database.  This must be done before the ITO can be accessed. 
 
Click on History on the TMS main menu. 
 
Click on Student Data on the History Menu. 
 
Click on the record to be returned and click on Move to Student. 
 
Copying History Data 
 
This function allows the user to copy information on a student who went to training in the past,  
into the active student database. An example of this would be for a student in history who went to 
school 3 or 4 years ago, is now going back for another course. This function allows you to 
"recapture" the information on the student again. 
 
Click on Copy History on the History Menu. 
 
Click on the left hand box of desired 
historical student record in the 
Historical Student Data (top portion of 
screen). 
 
Then click on the desired current 
student record in the Student Data 
(bottom portion of screen).   
 
Click on Copy Selected History to 
Student to copy the personal information 
on that student to the current, active 
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program.  
 
Click on Undo to undo and Find History or Find Student to find a record in those data tables. 
 
 
L.  TOOLS 
 
This utility function provides a means to change the upload/download paths, backup/restore 
TMS databases, and format disks.  
 
Click on the Tools function in the TMS Main Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Changing Download and Upload File Path 
 
Click on Download Path or Upload Path in the Tools Menu. 
 
Type in the correct file path for the C:\ drive that will point to the directory that contains the 
download or upload files for the SAN (Security Assistance Network). 
 
 
 
 
 
 
 
 
Note:  The file path for the SAN Web download is C:\TMS\DOWNLOAD.    
The file path for the SAN Web download is C:\TMS\UPLOAD. 
 
Backup/Restore 
 
The Backup and Restore functions in TMS Tools provide the means of backing up TMS data 
that could be lost if there was, for instance, a power interruption.  TMS data should be backed up 
on a daily basis.  While MASL and STL data can be reestablished by simply doing a new 
download from the SAN and corresponding updates in TMS, think about the possibility of losing 
all of the Student Data that has been entered over time.  So do your updates in a frequency that 
suits your particular usage of TMS. 
 
Click on Backup in the Tools Menu. 
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Insert a formatted high density disk, type in the correct disk drive, 
A:\ and click on Backup.  Include STL if desired. 
 
 
 
 
Click on the Restore function in the Tools Menu. 
 
 
Insert a previously prepared TMS Backup disk, type in the correct 
disk drive, A:\ and click on Restore. 
 
Network Installation 
 
To install TMS on a network, do the following: 

a. Install TMS on the network drive. 
b. Install TMS on each work station PC. 
c. At the work station PC, open TMS and ensure that the Network Path is set to the 

proper location (i.e. G:\TMS4\). 
d. Once you have verified that the path is correct, click on the Network Install button. 

 
Note: Make sure you do this at each work station PC. If you don’t, that PC will still be working off 
the data on its C:\ drive. 
 
Network Path 
 
Click on Network Path in the Tools Menu. 
 
Type in the correct file path for the network (i.e. G:\TMS). 
 
 
Network Install 
 
After verifying that the Network Path is correct, click on the Network Install button in the Tools 
Menu at each work station PC. This will effect the network installation. 
 
Formatting a Disk 
 
Click on the Format Diskette function in the Tools Menu. 
Insert a disk and select the A:\ drive. 
 
TPMR Use 
 
Click on TPMR on the Tools Menu to set TMS up for use during a TPMR.  SAO specific 
functions are turned off.   
This is a toggle function, simply click again to turn the SAO functions back on. 
 
User Role 
 
Click on User Role on the Tools Menu and select the 
appropriate user role. 
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M.  SEND TO SAN 
 
When you have made changes to any data field in TMS that appears with the title of that field 
underlined, TMS will then upload that new or changed data to the SAN either upon your exiting 
TMS or upon your selecting Send to SAN.  Thus, if you have:  changed your Point of Contact 
information in the Country Profile screen, entered new Student Data in the Student Information 
screen, or entered Arrival Information in the Student Arrival Information screen, then TMS will 
ask you if you wish to upload that data to the SAN. 
 
When you click on Exit TMS, the following appears. 
 
 
Click on Yes, Update to SAN in order 
to upload the data changes to the 
SAN. 
 
Click on No, Exit TMS if you do not 
wish to do the upload at this time. 
TMS will keep track of the fact that 
you have not uploaded the changed 
data. You will be asked again, the 
next time you attempt to exit TMS.   
 
 
 
Or, you can initiate the SAN Update by clicking on Send to SAN on the TMS main menu. 
 
 
Click on All Country Profile(s), or All Student Data, or History 
(upload yearly) to accomplish those individual updates. 
 
Or, click on Send All–Country Profile–Student Data–History to 
update all of those data tables. 
 
Click on Quit to exit. 
 
 
 
 
 
 
 
 
 
 
 
You will then receive the following message: 
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Your browser will connect automatically to the SAN. If not, click on the SAN hyperlink provided. 
 
Click on Yes if queried by the Security Alert screen. 
 
Log on to the SAN. 
 
 
 
After logging on to the SAN, 
click on the TMS Upload 
button to initiate the upload 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Highlight the file c:\tms\upload\tmsup.lzh , copy (press Ctrl and C keys) and paste (press Ctrl 
and V keys) that file into box.  Or, use the  Browse button to select the preceding file. 
  
Click on Upload file now in the SAN screen above to initiate the Upload. 
 
The following message is received if your upload was successful.   
 
 
 
 
 
 
 
 
Close the SAN internet connection and return to TMS. 
 
 
If your upload was successful, click 
on YES, Exit TMS. 
 
Otherwise, click on  
NO, Try Update Again or  
NO, Try Update Later. 
 
 
 
 
 
 



1-44 

N.  HELP 
 
The Help function provides an on-line help facility that can be obtained by simply selecting Help 
from the Main Menu or by pressing the F1 key from any menu. 
 
Click on Help from the TMS Main Menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
You have a choice of either selecting a specific detailed item from the alphabetical listing on 
the left or choosing a TMS main menu item on the right and then choosing a subordinate item 
under that main menu heading. 
 
You may select any item in the left hand column and you may select any item printed in green by 
clicking on that item.  All TMS Menu functions can be chosen on the right portion of the Help 
screen (listed in Green). Subordinate menu items can also be chosen.   
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Scroll down the alphabetical listing on the left and click on the desired item.  Remember to click 
on any item that appears in green for further information. 
 
Or, click on any menu item that appears in green on the right.  
Click on the Back button in top menu to return to the previous screen(s). 
 
Click on the Print button in top menu to print your Help instructions. 
 
At any time in the Help function, click on Search, and type in the topic 
desired.  The first time you click on Search, follow the dialogs to set up 
your Search function. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the forward and back arrows to move chronologically through the Help function.  
Remember that the Back button takes you back to the previous screen you were at. 
 
Remember that you can access the TMS Help function from any specific TMS function by 
simply pressing the F1 key while you are in the TMS function. A Help screen will appear for that 
specific TMS function. 
 
 
O.  EXITING TMS 
 
Click on Exit TMS to exit TMS. 
 
As stated above, if you have made 
changes to your data that need to be 
uploaded to the SAN, you will be so 
advised.  
 
Upload your changes daily to the SAN.  
Uploading at the end of the day makes a lot 
of sense. 
 
Click on Yes, Update to SAN and 
accomplish the upload. 
 
Otherwise, click on No, Exit TMS. 
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